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INFLUENCE OF CROSS-SECTION CHANGE DURING DIRECTIONAL
SOLIDIFICATION ON DENDRITE MORPHOLOGY, MACROSEGREGATION

AND DEFECT FORMATION IN Pb-6 %Sb ALLOY

CLAUDINE LACDAO

ABSTRACT

The purpose of this research is to examine the dendrite array morphology,
macrosegregation, and defect formation caused by the fluid flow at the abrupt cross-section
changes during directional solidification of Pb-6% Sb alloy. Four 24-cm long cylindrical
alloy samples were directionally solidified in graphite crucibles: two having a constant
diameter (9-mm) grown at 10.4 and 63.1 pm s, one having an abrupt cross-section
decrease (from 12.7 to 6.35 mm) and one having an abrupt increase (from 6.35 to 12.7 mm)
by pulling down the alloy containing cylindrical graphite crucibles from the upper hot-zone
of a stationary vertical furnace into its cold-zone below. Microstructures were examined
on transverse slices cut along the length of the directionally solidified samples. Dendrite
spacing and distribution were characterized on these transverse sections. The Pb-6% Sb
alloy was selected as a low melting point analog for commercially used multicomponent
nickel-base superalloys, because its thermophysical properties are well characterized. Also,
a density inversion occurs in the inter-dendritic melt in the “mushy-zone” during
directional solidification of this alloy, because the density of the melt decreases as Sb
content increases from the array tips at the top of the mushy zone to the eutectic at their

bottom. In constant cross-section crucibles, the formation of dendrite-trees in the mushy



zone will be subject only to this “plume type” convection as solidification proceeds from
the bottom end of the crucible to its top. Whereas in crucibles with abrupt cross-section
change, the solidifying mushy-zone will be subject to additional ““cross-section change
induced” solidification shrinkage flow, when the speed of the liquid flowing downwards
to feed the solidification shrinkage occurring below, will either suddenly accelerate or
decelerate, because of the abrupt area change. This sudden change in the incoming fluid
speed may break slender side-branches of dendrite trees. These broken dendrite fragments
may rotate, sink, and grow further to develop into misaligned “spurious” grains. The
“plume type of flow” is different than the “steepling convection flow” which was recently
examined during directional solidification of Al-19% Cu and Al-7% Si alloys by Dr.

Masoud Ghods in our laboratory.
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CHAPTER |

GENERAL INTRODUCTION

1.1. Alloy Industrial Applications and Solidification

1.1.1. Single Crystal Turbine Blades

Bridgman directional solidification technology is widely used to fabricate the first
stage turbine blades used in the modern gas-turbine engines for applications in both the
aircraft engines and terrestrial power generating engines.? These first stage turbine blades
are the most critical component in advanced gas turbine engines, as these are the most
stressed high-temperature components of a gas-turbine engine.® Multicomponent nickel-
based superalloys having a mono crystal dendrites oriented parallel to [100] direction along
the blade length, are fabricated by directional solidification (DS) using ceramic investment
casting shell molds. Because the [100] orientation provides the blade its maximum stress-
rupture and thermal fatigue life, presence of any spurious (not aligned along [100]) grains
is highly detrimental to its mechanical properties and must be avoided during directional

solidification.*® These blades have a complex geometrical shape, involving cross-section



increase and decrease at the blade-root and often a cross-section increase at the blade-tip
locations. In addition, they also have complex internal cooling channels which are formed
by directional solidification of the melt through many cross-section changes. Two
techniques are used to achieve the [100] orientation. The first technique uses a [100] single
crystal seed kept at the shell bottom, which is re-melted and fused with the rest of the melt
before directional solidification of the blade. The other technique uses a small diameter
helix shaped constriction at the shell bottom to help select one near [100] orientation grain
from many incoming randomly oriented grains from below, which are generated when the
hot melt, poured through the shell touches a quench block kept at the shell bottom.* A
presence of “misoriented” spurious grains in the blade casting is a major cause of rejection
during the process. It is believed that shrinkage-driven (thermal volumetric contraction)
and thermosolutal convection associated with solidification through cross-section changes
are responsible for the formation of spurious grains at these cross-section change
locations.*

1.1.2. Conventional Casting

In metalworking, conventional alloy casting refers to a process in which hot liquid
metal melt is poured into a cold mold that contains a hollow cavity of the desired geometry
to allow for the metal solidification. Component composition and mold geometry dictate
heat transfer, thermal gradients, and solidification speeds. As shown schematically in
Figure-1, solidification begins when the hot melt comes in contact with the cold mold
forming many equiaxed grains. Competition among nucleation sites influences the growth
of these grains. Grains oriented more favorably to the heat extraction direction grow at the

expense of the unfavorably oriented ones resulting in a columnar grain morphology. The



rest of the melt continues to cool as solidification proceeds. If the melt undercools below
its liquidus temperature, new randomly oriented grains of solid nucleate and grow yielding
the equiaxed grain morphology during the final phase of solidification in the casting
interior (Figure-1).
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Figure 1 Sketch representing columnar to equiaxed grain transition in a traditional cast.®

1.1.3. Directional Solidification

Directional solidification imposes a relatively constant thermal gradient in a single
direction to maintain a single liquid-solid interface. Heat is extracted in only one direction
by maintaining adiabatic walls on all sides except one. During solidification, the alloy
containing ampoule is moved away from the heat source at a desired ‘growth’ rate R [cm/s]
while maintaining an imposed thermal gradient G [K/cm] at the liquid-solid interface. For
a high thermal gradient to growth rate ratio in a binary alloy, the liquid-solid interface has
a planar liquid-solid front morphology. However, for most other cases the alloys are grown
at a low thermal gradient to growth rate ratio where DS results in the formation of a two-
phase (liquid+solid) mushy zone between the all liquid region at the hot end above, and the
all-solid region at the cold end the mold below.”

1.2. Mushy Zone Morphology



1.2.1. Dendrites

The mushy-zone, shown in Figure-2 for a transparent organic alloy (Succinonitrile
— 9 wt. % Water) typically consists of arrays of “tree” like features, called primary
dendrites. The trunk diameter of these primary dendrite trees increases from their tips in
the vicinity of the all-liquid region above to the eutectic temperature at the bottom below
which all solid-region exists. These trees in Face Centered Cubic (FCC) alloys have
orthogonal side-branches (secondary arms), the side-branches have their own orthogonal
branches (tertiary arms) and so-on. The four-fold orthogonal symmetry of the side-
branching in FCC is associated with the requirement that the solid phase growing along the
[100] direction surround itself with the lowest liquid-solid surface energy planes, which
are (111) for the FCC crystals. The primary dendrite spacing, primary dendrite trunk
diameter, secondary and tertiary branch spacing are all dependent on growth conditions
and the alloy physical properties. Faster growth speeds produce finer features and tighter
packing, and therefore smaller grains.” Morphology and distribution of primary dendrites,
secondary dendrites and tertiary dendrites depend upon the local alloy composition and
local solidification conditions, and they all determine the mechanical properties of the
solidified components. Therefore, any inhomogeneity in the microstructure is

disconcerting.



Figure 2 Succinonitrile — 9 wt. % Water “Transparent alloy” directionally solidified (~ 5um s-1 ,~30Kcm-
1) (Dr. Grugel, NASA-MSFC)®

1.2.2. Eutectic

As shown schematically in Figure-3(a) in binary alloys the primary dendrite tips
begin to form from the surrounding liquid as the temperature falls below the alloy liquidus
temperature (Ti). Because of the curvature undercooling the primary dendrite tip
temperature (Tt) is, however, slightly below T,. Therefore, in alloys where the solute
partition coefficient (k) (ratio of the solute content of the solid phase and that of the liquid
in equilibrium) is less than one, the composition of the liquid at the array tips (Cy) is slightly
above the nominal solute content of the alloy, Co. Since the diffusion coefficient of solute
in solid is at least two orders of magnitude slower than that in the liquid, further
solidification of the primary dendrites results in continued solute enrichment of the
interdendritic melt, because of the solute continually being rejected from the growing solid

and getting accumulated in the interdendritic melt. The interdendritic melt ultimately



reaches the eutectic composition at the base of the dendrite arrays and the two-phase
eutectic solid forms there. The interdendritic melt is, therefore, solute poor near the array
tips and solute rich at the base of dendrite array. Depending upon whether the increasing
solute results in increased melt density, such as in Al-19 % Cu alloy, or it results in reduced
melt density as is the case with the Pb-6 % Sb alloy the density of the interdendritic melt
in the mushy-zone either increases downwards or decreases downwards during directional
solidification with melt on the top and the solid below. Natural convection driven by
gravity can occur when the less dense melt is below and the higher density melt above.
Since the temperature gradient alone (higher temperature less dense melt on top of the
lower density cooler melt below) is stabilizing during directional solidification, convection
in the mushy zone should solely depend upon the solutal effects alone.
1.3. Thermosolutal Convection During Directional Solidification

1.3.1. Solutally Stable and Thermally Stable Interdendritic Melt Configuration

The interdendritic concentration gradient in alloys where solute-rich liquid is
densest at the dendrite roots (Co < Ctip < Cg) stabilizes natural convection as seen on Figure-
3(a) as is the case for Al-Cu systems (Aluminum: 2.70 g/cm?® and Copper: 8.98 g/cm? at
melting temperature).” Therefore no convection is expected in the mushy-zone. The liquid
alloy, in and above the mushy zone, in an upward directional solidification setup, is also
thermally stable against natural convection because of earth’s gravitational vector (g).

However, small radial thermal gradient or any misalignment of the crucible with
respect to gravity vector can initiate natural convection via a “steepling type” of
convection. The “steepling convection” occurs when the solute rich (Ct) heavier density

melt ahead of the leading dendrite in an array begins to flow radially downwards towards



the tips of its lagging neighbors and stifles their growth further. This results in a mushy-
zone which does not have a uniform mushy-zone length through-out. The primary dendrites
get clustered (“steepled”) in the leading regions and the solute content radially outwards
can sometimes reach the eutectic composition, Ce. This results in extensive radial chemical
inhomogeneity (macrosegregation) and also microstructural inhomogeneity as shown in

Figure-3(b) for a Al-19% Cu alloy solidified at 10 um s growth speed.
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Figure 3 (a) Schematic Temperature, Concentration and Density Profiles in interdendritic Liquid, Al-Cu®
(b) Image of transverse slice of an Al-19 % Cu alloy, grown at 10 pm s-17. This depicts an example of
transverse phase macrosegregation.

1.3.2. Solutally Unstable and Thermally Stable Interdendritic Melt
Configuration

Directional solidification of Pb-6% Sb alloy on the other hand is expected to result
in a thermally stable, but solutally unstable interdendritic melt configuration as is shown
in Figure - 4(a). Despite the stabilizing thermal profile a density inversion occurs when
the solute-rich melt near the dendrite roots is less dense than that near the dendrite tip
(Lead: 11.34 g/cm?® to Antimony: 6.68 g/cm® at melting temperature). This convection
called “plume type” convection leads to compositional inhomogeneities along the

solidified length of the sample (longitudinal macrosegregation),®® and also results in



microstructural inhomogeneities on the sample cross-section (as shown in Figure - 4(b)).
A highly segregated channel-segregate can clearly be seen in this transverse microstructure

of a Pb-6% Sb alloy directionally solidified at 10.4 pm s .
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Figure 4 (a) Schematic Temperature, Concentration and Density Profiles in interdendritic Liquid, Pb-Sh®
(b) Image of transverse slice of an Pb-6 % Sb alloy, grown at 10.4 um s™. This depicts an example of
channel formation as because of plume type thermos-solutal convection.



1.4. Relevant Works
1.4.1. Convection in Pb-Sb Binary Alloy System
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Figure 5 Schematic Convection Profiles in Directionally solidified Pb-Sb systems under (a) cross section
contraction and (b) expansion.

Figure - 5 (a) and (b) are schematic representations of the expected interactions
between three types of potential convective fluid flows and the mushy-zone during
directional solidification of Pb-6% Sb alloy in a graphite mold containing abrupt changes
in cross-sections; (1) thermal convection indicated by circular dotted-line flows caused by
radial thermal gradients, (2) “solidification-shrinkage” convection indicated by the vertical
down-wards arrows, and (3) thermosolutal convection indicated by vertical upwards
arrows with dotted lines.

The two-fold increase in the thermal diffusivity of the solid metal forming from the

liquid causes an inward heat flow from the graphite mold creating a radial thermal gradient

10



in the melt.® This initiates “thermal convection” cells where the liquid flows upwards close
to the mold walls and downwards at the center as depicted in Figure - 5 (a.1) and (b.1).
This also causes the isotherms to become convex toward the all-liquid region above the
mushy-zone.!

Shrinkage convection occurs due to the significantly high thermal expansion
coefficient of the liquid melt (Br) compared to the solid. A solidifying liquid shrinks in
volume as it solidifies (solid is less dense than liquid) therefore the liquid rushes
downwards to maintain continuity. There is a constant shrinkage convection pushing the
fluid downwards even in the constant cross-section region of the mold. However, its
magnitude increases when the solid forming in the larger cross-section below begins to
reach the abrupt cross-section reduction region, because the smaller cross-section liquid
column has to now feed the larger cross-section solidifying below (Figure - 5(a)). In a
Ccross section expansion situation as seen on Figure - 5(b), the magnitude of the shrinkage
flow decreases as compared with the larger cross-section portion of the mold above because
a smaller cross-section solidifying below is being fed by a larger cross-section area melt
pool above.

There is also the convection that occurs because of the temperature and
concentration gradient within the interdendritic melt discussed in the previous section. The
density of the melt is lower at the base of the dendrite, this generates a “plume” type of
flow where the liquid flows upwards against the gravity vector. This flow can bring solute
rich liquid upwards faster than the local isotherm growth speeds which can cause localized
remelting and fragmentation of the slender side-branches already formed there.*2

1.4.2. Theoretical Models
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1.42.1.  Primary Dendrite Nearest Neighbor Spacing Model

Analytical or numerical modeling for mushy-zone dendritic array morphology
formation during directional solidification involves consideration of multiple parameters.
Microstructure characteristics such as primary dendrite spacing, the dendrite tip-radius, and
tip composition have been analytically and numerically modeled after making many
simplifying assumptions.** Some of these assumptions include pure thermal and solutal
diffusion (no convection) and simple “needle” (unbranched) shaped primary dendrites.
Numerical models have been used to simulate convection through a mushy-zone of
dendrites™>1¢, but several simplifications were made to solve for the moving liquid-solid
interface. The primary challenge for numerical simulation has been the “non-linear” nature
of the phenomenon. Convective contribution to the heat and solute transport in the melt,
mush, and the solid has only been calculated for a “time invariant liquid-solid mushy-zone
structure” (for example known and constant permeability), but the “mushy-zone” dendritic
array morphology (for example permeability) is changed by the presence of “convection”.®

Despite these limitations, several semi-theoretical models have been proposed to
predict some of the macro morphology parameters such as dendrite tip radius (p), dendrite
tip composition (Ctip), and primary spacing of dendrite trunks (A). Some popular models
in literature include Kurz-Fisher®3, Trivedi'’ and Hunt-Lu'*8, The Hunt-Lu model is a
semi-empirical model that uses experimental polynomial ‘fit’ parameters and has proven
to correlate well over a wide range of growth speeds, thermal gradients, and compositions.
This will be the only model used to compare experimental results for primary spacing. The

Hunt-Lu model [HL] is a function of the dimensionless parameters:

, _ Gr
T (mCo)?
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G is the effective thermal gradient, I is the capillary length (proportional to the ratio of
solid-fluid surface energy to the heat of fusion), D is the diffusion coefficient, k is the solute
partition coefficient, Co is the initial alloy composition, mL is the liquidus slope, and A is
the trunk diameter. For calculation, all variables are assumed to be constant. The following
is the HL model with parameters:
e Curvature Undercooling AT’
AT/, = 0.41(V' — G")°51

e Tipradius p
2T

P=AF AT

AT, AT,
e Primary spacing A’

A = 0.15596V' @079y — 1)0.75 06028

r i 2
a=—1.131-0.1555log (G ) — 0.007589[lo g (G )]
As referenced for the Pb-6 %Sb system in Table I, k=0.31, D=5x10-5 cm2s-1, I'=0.12

umK-1, m=6.62 K/wt.pct. and Co=7 wt. pct.

Table V Select thermophysical properties of Pb — 6 wt. pct. Sb System, used in theoretical models to predict
primary dendrite spacing. %

Name Variable Units Value
Liquid Temperature TL C 288.1
Liquid Slope mL K/wt% -6.78
Solute Partition Coefficient k Dimensionless 0.31
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Eutectic Temperature TE C 252.5
Heat of Fusion Ahf Jm-3 2.79x108
Eutectic Composition CE wt% 11.2
Gibbs-Thomson Coefficient r umK 0.105

1.4.2.2.  Primary Dendrite Trunk Diameter Model

The primary dendrite trunk diameter is a useful metric that correlates well with the
actual solidification processing parameters and complements the conventionally used
primary, secondary, and tertiary arm spacings. A model developed by Tewari et. al ** was

used to calculate the predicted valued for primary trunk diameter in this study.

14 VGt
3 96 DlF l mlCO 3
= n +
¢ VG(1-k) 1+1‘;%?, o

Equation 1

Where $o = 6.597; is the initial trunk diameter with r; being the dendrite tip radius, D
is the solute diffusion coefficient in the liquid, V is growth speed, G is thermal gradient, I
is Gibbs-Thompson coefficient, k is solute partition coefficient, my is liquidus slope and C,

is the alloy composition.

1.5. Pb-Sb Binary Alloy Melt Characteristics
Solute enrichment during binary alloy solidification changes the melt density. In a
Pb-Sb alloy system, the solute (antimony) has a significantly lower density than the solvent
(lead) (6.684 g/cm?® and 11.34 g/cmd respectively at melting point). A density inversion
occurs in the interdendritic melt in the “mushy-zone” during directional solidification,

because the density of the melt decreases as Sb content increases from the array tips at the
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top of the mushy zone to the eutectic at the bottom. This unique phenomenon that leads to
various macrosegregation was one of the reasons why Pb-6 % Sh was selected for this
study. A Pb-Sb phase diagram is shown in Figure - 6 along with tabulated thermophysical
properties required by theoretical models to calculate primary dendrite spacing listed in

Table I.

700

600

500 |
T (°C)

400 | /
1

327.5 r
300 W —— !
b 251.2 k!

35 11.2 5.5
200 — T v
a+B 1
100 G2 . !
Pb 10 20 30 40 50 60 70 a0 a0 Sk
wt % Sb

Figure 6 Pb-Sb Phase Diagram?°

Liquid temperature is the melting temperature, liquid slope is the slope of the
liquidus line on the phase diagram, solute partition coefficient is the ratio of compositions
for the two phases at a given temperature, eutectic temperature is the temperature at which
eutectic phase forms, eutectic composition is the overall composition of the eutectic phase,
Gibbs-Thomson coefficient is a constant describing the surface curvature effects for phase
equilibrium, and the solutal capillary length is the characteristic length defined by the
surface tension between the two phases.

1.6. Experimental Goals
Macrosegregation caused by a cross-section change attributed to the changes in

thermally induced flow was previously examined and modeled for Al-4.5 % Cu.%102
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Multiple studies have indicated that convection is the primary cause of irregular mushy-
zone morphology that was observed as decrease in primary spacing, secondary spacing,
and misoriented grain formation.?228 In Pb-Sh systems density inversion induces additional
convection in the interdendritic region. There are limited experimental studies which
examine both the macrosegregation and the microstructural changes caused by convection
associated with cross-section change during directional solidification in Pb-Sb systems.
The purpose of this study is to examine the mushy-zone morphology and composition
change associated with cross-section change during directional solidification of Pb — 6 wt.
pct. Sb alloys at varying directional solidification growth speeds. The lead-antimony alloy
was selected in-order to consider the mushy zone convection caused by melt density
inversion (solutal-driven convection) and to observe the role of “cross-section change”
driven convection during directional solidification. This project has four specific purposes:

1. Carry out directional solidification of Pb-6% Sb alloy through constant cross-

section at two growth speeds: 10.4 and 63.1 um s-1.
2. Carry out directional solidification of Pb-6% Sb alloy through cross-section
increase and cross-section decrease at low growth speed.

2. Measure mushy-zone morphology (primary dendrite spacing, primary dendrite

trunk diameter) along the length of directionally solidified samples by using image-

analysis techniques and establish trends if any.

3. Establish image analysis techniques for a quantitative analysis of phase amounts

distribution in the microstructure as an indicator of macrosegregation.

4. Measure transverse and longitudinal macrosegregation associated with cross-

section change during directional solidification and establish trends if any.
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This data is expected to help identify solidification processing parameters for future low

gravity experiments on the International Space Station.
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CHAPTER I

EXPERIMENTAL AND ANALYTICAL PROCEDURES

2.1. Bridgeman Furnace Apparatus

Directional solidification was conducted using the apparatus set up shown in Figure
- 7. The assembly consists of a cylindrical quartz chamber attached to two stainless steel
flanges for the top and bottom support. To maintain good vacuum during solidification a
diffusion pump vacuum was used to keep the chamber at ~2*10™* torr. A sixty watt RF
power supply is used to create the hot-zone of the Bridgeman furnace assembly.
Temperature along the length of the crucible is recorded by a data logger from four
thermocouples. The cylindrical hollow graphite susceptor is enclosed within a 28 cm long
insulating alumina shell. To minimize heat loss above the cylinder a 0.5 cm insulating shell
is kept at the top portion of the susceptor and a 2 cm long insulating ceramic hollow disk
was placed at the bottom of the susceptor. Two tantalum wires tied to the top stainless steel
flange kept the furnace assembly within the alumina shell. The lead shell and the induction
heating coils that make up the RF generator can be seen from a zoomed in image on the

right in Figure - 7. The graphite crucible containing the Pb-6% Sb alloy cylinders (will be



discussed in great detail later) is inserted into the hanging furnace from the bottom for alloy
re-melting and its subsequent directional solidification. The alloy containing crucible is
attached to a stainless-steel feed through rod at the bottom. The sample is kept within the
graphite crucible as it is withdrawn from the furnace to cool the water cooled inner walls
of the graphite enclosure. Flowing water within the two-walled assembly of the chamber
allows the inner wall to be kept at room temperature. A DC motor coupled to a worm gear
arrangement is used for the sample translation. Vertical translation allows the graphite

crucible to be pulled out or inserted into the Bridgeman furnace.

=

Tl

Figure 7 Images of Bridgman-technique furnace assembly for directional solidification &

2.2. Graphite Crucible and Pb-6% Sb Sample Assembly
The feed rods used in these experiments were prepared using lead and antimony
of highest purity. Figure - 8 below shows a typical granite crucible used for these

experiments. From the cold end of the crucible, a 9 mm diameter by 2.8 mm long Pb-6 %



Sb alloy seed is inserted with known [100] crystal orientation. To fuse feed melt with the
[100] oriented Pb-6 % Sb alloy seed kept at the bottom, the cast feed rods inserted from
the top of the crucible are melted during heating. It is important to take extra caution to

ensure only partial melting of the [100] seed at the bottom.

Figure 8 Image of typical graphite crucible used for solidification

2.3. Directional Solidification

The graphite crucible set up is inserted into the vacuum chamber and attached to
the stainless steel feed through a rod passing through the bottom flange. The mechanical
and diffusion pump is then used to evacuate the quartz chamber and apply a 2*10* torr
vacuum. The cooling water valves are opened and RF generator turned on. A steady-state
hot zone temperature of about 750 °C is achieved by heating the graphite crucible at a
preset temperature. It is then inserted into the furnace and TC1 through TC4 temperatures
are continuously recorded. The feed rod is re-melted and fused with the seed aligned at the
bottom. The sample is withdrawn from the furnace at the desired growth speed. Table II

list the growth speeds for four of the directionally solidified specimens.

Table VI Growth speeds applied to Pb — 6 wt. pct. Sb samples

Sample ID Sample Dimension Growth Speed
Pb-Sb-12-24 Constant 9 mm 10.4 um/s
Pb-Sb-12-22 Constant 9 mm 63.1 um/s

Pb-Sb-3 12.7 - 6.35 mm 11.5 um/s
Pb-Sb-1 6.35-12.7 mm 8.7 um/s

Thermocouple ID# TC1, TC2, TC3, and TC4 temperature profiles recorded during

directional solidification of sample Pb-Sh-3 are shown in Figure - 9 as an example of a
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typical temperature profile during directional solidification. The temperature versus time
data has been transformed to temperature versus distance data using the known sample

translation speed, in this case, 11.5 pm/s for Pb-Sb-3.
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Figure 9 Temperature versus distance for thermocouples TC1, TC2, TC3, and TC4 for sample Pb-Sh-3.

2.4. Specimen Preparation and Metallography

2.4.1. Longitudinal Samples

The crucible was removed from the furnace after complete cooling. It is then
prepared for cutting and mounting. Approximately 9 mm long portion, starting from about
-3.5 mm below the neck of contracting cross-section to +5.5 mm. Approximately 5.1 mm
long portion was cut for the longitudinal image of the experiment under abrupt expansion,
starting from about -0.7 mm below the neck of the expansion +4.4 mm above.

2.4.2. Transverse Samples

Transverse images along the length were taken to examine morphology features

such as trunk diameter, nearest neighbor spacing, and fraction eutectic. To distinguish the
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correct orientation, each slice was marked which side was “hot”, closest to the
aforementioned “hot-zone” during solidification). Each was then mounted, polished, and
imaged for data extraction and analysis. Sample IDs with the corresponding location in the
samples are shown in Tables V - VIII in the appendix of this report.

2.4.3. Cutting, Mounting, And Polishing

A low-speed, variable RPM, precision wafer saw was used to cut the samples at
various pre-determined locations shown in Tables V-VIII from the appendix. Diamond
tipped low-grit precision saw blades of diameter 102 mm diameter by 0.3 mm thick were
used. Between 25 - 50 grams of weight was added to the cutting arm, and blades were
continuously wetted with cutting oil. Once sliced, the specimen’s “hot side” was marked
and then smooth with a 9 mm Buehler Chemomet polishing cloth.

The specimens were then cold mounted. A cylindrical plastic mold was lubricated
with industrial oil and the specimen was placed in the middle of the mold with the “hot
side” facing downward. In a separate container, 30 mL of Struers Epofix resin was
carefully mixed with 15 mL of Struers Epofix hardener to create an epoxy mixture. The
epoxy mixture was then poured over the cylindrical mold and allowed to cure overnight.
A Leica SM2500E Ultramiller was then used to further prepare the surface of the mounted
sample for polishing and incident light investigation. The surface preparation procedure
consists of two different steps: a preparation step carried out with a pre-miller and a
finishing step during which a mirror-like surface is obtained. Any remainder particulates
on the surface of the sample were cleaned and eliminated by using an ultrasonic bath.

An automatic wet abrasive grinder was used to ground and polish the samples. A 9

mm Buehler Chemomet polishing cloth was used in the final polishing stage. Chemomet
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cloth is soft, porous, chemical-resistant, synthetic pad for softer materials which works well
with the Pb-Sb surface. There are two layers of polishing grade, speed, force and time that

was applied to the specimens listed on Table Il and IV below.

Table VII Polishing procedure for 9-mm and 12.7-mm diameter sections sample preparation

Average Grade (Grit) Downward Time (min) Polishing Pad RPM
Force/Sample
9 mm Chemomet 5 Ibs 6 110
9 mm Chemomet 5 lbs 6 110 (opposite rotational direction)

Table VIII Polishing procedure for 6.35-mm diameter sections sample preparation

Average Grade (Grit) Downward Time (min) Polishing Pad RPM
Force/Sample
9 mm Chemomet 3 lbs 4 110
9 mm Chemomet 3 Ibs 2 110 (opposite rotational direction)
9 mm Chemomet 3 lbs 2 110

To eliminate contamination during polishing 0.05 pm alumina slurry suspension
was generously added to the surface of the polishing cloth. It is imperative to thoroughly
clean the polishing cloth and specimens under running water after each round of polishing
to eliminate alumina residue. Samples often need to be re-polished, solvated with ethyl
alcohol, or cleaned in an ultrasonic bath to remove remaining colloidal alumina particles
and oil. Avoid over-polishing as this can lead to wearing away of the softer alpha phase,
creating an embossed surface with beveled edges on the final image that will be captured.
Once finished, each sample was dried and then observed under the microscope for image
capturing.

2.4.4. Microscopy

A metallurgical brightfield inverted Nikon microscope, 5.0-megapixel digital
camera attachment and SPOT 5.0 Image software were used to capture magnified images
of the sample’s surface. Images were recorded at 5 times magnification for all specimens
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for uniformity. For such a large field of view, several overlapping images were manually
staged. At larger magnifications, 12.7 mm (1/2 in) diameter cross-sections required
upwards of 120 images to cover the field of view. Original digital images were saved with
.TIF extensions at the highest quality. Parameters such as light exposure, gamma
corrections, gain, and color-filters were manually selected sample-to-sample to create best
image quality. Ideal image quality was seen to possess constant light intensity across the
whole field of view, for one phase and between samples and images. High contrast light
absorption differences between lead and antimony also aid in distinguishing phases that
were present. It was important to clean and align the microscope’s projection lenses to
capture consistent images. Typical settings include 140 ms of exposure, a 1.00 gain factor,
gamma correction of 0.50, and a green-tint light filter. For each sample, a known 1 mm
scale was imaged to record pixel to millimeter ratio for images. Oxide layers were known
to grow rapidly on the metal’s surface if samples were stored for later microscopy. This is
often avoided to eliminate unevenness in the overall quality of the image.
2.5. Image Analysis

2.5.1. Image Stitching

Image stitching is the process of multiple photographic images with overlapping
fields of view to produce a segmented high-resolution image by calibrating optical
aberrations, and blending where applicable. Transformations for microscopic images are
not required to adjust distortions. “Image registration” of locations or the process of
transforming different sets of data into one coordinate system is significantly simplified by
image stitching. Difficulties in conducting image stitching stem from intensity differences

between images, intensity gradient in an image and partial unfocused features. Two images
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can be blended by averaging intensities and colors to hide seams. Larger digital files require
more computing capabilities, and therefore more difficult to stitch. Image stitching is a
bottleneck procedure due to these potential complications. Note that the complexity of
stitching will lead to computation errors, which leads to errors in image analysis. Adobe
Photoshop CS5.1 on 64-bit Windows 7 on an HP z210 workstation was used to stitch the
images in this study. A 120 image stitch, such as that for the larger cross-section area slices
required 10 - 14 hours of computing time, and often lead to computer ‘freezes.” A smaller
10 - 20 image collection for smaller cross-section area slices typically required 10 - 15
minutes to stitch.

Before analyzing the images for data subsequent slices are aligned to ensure that
all have a similar reference point for rotation and centered within a background. Images
were aligned using the original vertical cuts created for reference as microscopy requires
manual alignment at a high magnification, and would, therefore, be more tedious. For the
whole transverse end caps, dendrite feature’s orientation were measured between images,
and then rotated to match.

2.5.2. Primary Dendrite Trunk Diameter And Dendrite Trunk Centers

An image processing program called ImageJ v. 1.46 was used to measure primary
dendrite trunk diameter. ImageJ is an open source image analysis program that can be
downloaded from http://rsh.info.nih.gov/ij/ for a variety of operating systems. Drawing a
line between two pixels with (x,y) coordinates can calculate length where d = /x2 + y2.
Appropriate measurement values must be selected prior to drawing line segments. This is
be done by choosing Analyze > Set Measurements >Bounding rectangle > OK, which

measures a rectangle bounded by the two end points of the line segment acting as a
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diagonal. After choosing the line-selection tool and making a line-selection on an image,
choose Analyze > Measure will print a set of numbers for a ‘Bounding rectangle.’

A bounding rectangle has 6 measurements labeled BX, BY, Width, Height, Angle,
and Length. A rectangle can be drawn with the extreme values of x and y for the four
corners of the rectangle provided a line segment with two sets of (x,y) coordinates. The
line drawn is arbitrarily set as one of the diagonals. ‘BX’ and ‘BY” are the upper-left x and
y coordinate in pixels in relation to the upper-left corner of an image, ‘Width’ and ‘Height’
are the width and height of the bounding rectangle, ‘Angle’ is the minimum angle between
the drawn line and an imaginary line facing due right from the ‘starting’ point for the drawn
line, and ‘Length’ is the length of the drawn line.

For a dendrite trunk diameter measurement, two lines are drawn such that each line
IS a minimum distance spanning the trunk, as shown in Figure - 10. For an ideal well-formed
dendrite, these two lines will be perpendicular to each other. The diameter of that trunk
was taken as the average of those two lines lengths in pixels. Dendrite center was also
calculated from these measurements by knowing the intersection of these two lines. This
calculation was done through a computer program written in VBA coding language for
Excel 2010, listed in the appendix. Though dendrite center absolute (x,y) coordinates are
irrelevant, coordinates are important for spacing calculations which will be discussed in

the later sections.
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Figure 10 (a) A typical RGB image and (b) screen captures of bounding rectangle measurement for trunk
diameter

2.5.3. Nearest Neighbor Spacing

Numerical analysis using (x,y) coordinates measured in ImageJ allows for the
calculation of nearest neighbor spacing. The minimum of the set of all possible distances
was calculated with a caveat that the set of all possible distances will not contain duplicates
through the symmetric property of equality.® Given a set of (x,y) coordinates, a VBA macro
code for Excel 2010 was written to calculate nearest neighbor spacing. This code is

included in the appendix for reference.
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2.5.4. Fraction Eutectic

2.5.4.1. Thresholding

The composition at a particular location can be calculated if the fraction eutectic is
known. Fraction eutectic can be calculated using the area covered by the eutectic region
divided by the total area of the sample. The difference in color intensities of the lead-rich
and antimony-rich region based on their light absorption allows for identification of distinct
structures from captured images. High-intensity lead-rich o phase can then be separated
from the antimony-rich eutectic. Thresholding allows for the separation of pixels based on
intensity values. For an 8-bit image, pixels are labeled between 0 and 255 based on intensity
where black is assigned a value of 0 and white is 255. A number is chosen where all
numbers equaling that value or higher will be given a value of 255 and all lower a value of
0. Thresholding transforms an 8-bit grayscale image into a binary image of black and white
pixels. Picking a proper cut-off intensity value is vital for accuracy to ensure user bias is
not introduced as image intensity varies from sample to sample. ImageJ has a built-in
thresholding algorithm under “default” which was used for thresholding.

A “Region of Interest” must always be selected before thresholding to eliminate
unwanted background pixels that will not be included in the later calculation. In the ImageJ
menu select: Edit > Selection > “Create Selection.” To execute the algorithm select: Image
> Adjust > “Threshold.” The image can be inverted so that the dendrite phase is black and
the antimony-rich phase is white. In the case where the values for black and white are
inverted select: Image > Lookup Tables > “Invert LUT”. Hover over the black and white

regions to ensure that the assigned values correspond to the correct color.
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Figure 11 Typical example depicting the thresholding procedure of an 8-bit image of an Pb-Sb transverse
slice with corresponding intensity histograms.

2.5.4.2. Watershed

The eutectic phase is composed of both antimony-rich (white region) and lead-rich
phase (black regions within eutectic). Since not all black pixels can be considered a fraction
of the dendrites as seen from Figure - 11, the lead-rich metastable phases remaining within
the eutectic which are colored similarly to the o phase should be separated and eliminated
prior to fraction eutectic calculation. A watershed algorithm was used to accomplish this.

A watershed transformation draws 1 pixel wide white pixels through geographical
minimum distances between regions of white. Within the binary image, the antimony-rich
white particles embedded into the lead-rich black landscape are connected by a spider web
of lines, sectioning the lead-rich black landscape into particles. It should be noted that the
drawn white pixels add to the white count and subtract from the black count by 0.5 - 1%
of the total pixel count (which can be calculated by [black particle count before watershed]

- [black particle count after watershed]).
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Figure 12 Typical example depicting the watershed and particle area cut-off procedure of a binary image.

2.5.4.3. Particle Size Cut-Off
After watershedding the image, individual particles are created from the previously
connected lead-rich black regions within the eutectic. To eliminate eutectic a phase from
being included in the calculation of primary dendrite o phase, particles having areas smaller
than a specified pixel area cutoff value were ignored while measuring the area fraction
occupied by primary dendrites. Pixel area cutoff value ranges from 1000-2500 pixels and
may vary from image to image. Different cutoff values will affect results by 1-2% for 100%
increase or decrease in area cutoff. Once this value is determined, the eutectic o phase
particles can be selected as a “Region of Interest” and are then filled with white to eliminate
its fraction contribution.
2.5.4.4.  Fraction Eutectic Calculation
Fraction eutectic can be calculated once the eutectic black particles (eutectic o) are
eliminated and a binary image has been created. Given a ‘Region of Interest’, the mean

intensity value can be calculated. Particle’s values are 255 for white or 0 for black.
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Therefore, [mean intensity]/255 = [fraction alpha] and 1-[fraction dendrite] = [fraction
eutectic]. Then from the lever rule, C,* = f, * (C3* — C5P) + C#, where C," is the local

average composition, and f,is fraction eutectic. As this process is standard from image to

image, a macro was written for ImageJ to process a batch of images.
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CHAPTER 111

RESULTS AND DISCUSSION

3.1. Effects of Growth Speed on Solutally Unstable Pb-6wt% Sb with Constant
Cross Section
3.1.1. Transverse Macrostructure Images
Sample transverse images for Pb-6 % Sb grown at 10.4 and 63.1 pum/s growth
speeds are shown in Figure - 13 (a) and (b) below. The orthogonal bright features are
representative of the solute-poor primary o phase dendrites. The darker gray area is

representative of the eutectic region comprising of both o and B fine solid phases.



(b)

Figure 13 Transverse macrostructure of Pb-6Sh 9 cm from base grown at (a) 10.4 um/s (b) 63.1 um/s

The dark looking, eutectic-concentrated regions present in the transverse images
signify macrosegregation from channel formation. This means that in some regions the
upper composition and permeability range with respect to the material properties (which

can be further characterized by the Lewis and Prandtl numbers that were not calculated in



this study) allowed channels to become diffuse and convection to become general and
essentially turbulent.?® In addition, the transverse images suggest that increasing growth
speed decreases trunk diameter. From visual observations increasing growth speed also
seem to decrease the primary dendrite spacing. Trends in longitudinal chemical
inhomogeneity, trunk diameter and primary dendrite spacing involved further image and
quantitative analysis which is discussed in the sections that follow.

3.1.2. Longitudinal Macrosegregation Dependence on Growth Speed and

Fraction Solidified

The average composition values after solidification at various locations were
calculated from fraction eutectic data obtained from transverse images at each
corresponding locations and the equation C, = —3.351 * (fz)? + 13.48 = f; +
0.802 relating fzto the average solute content C;. * Figure - 14 (a) and (b) illustrates the
relationship between the ratios of the average composition to the nominal composition as
fraction solid increases for specimens with constant cross section grown at 10.4 and 63.1

um/s, respectively.
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Figure 14 Longitudinal macrosegregation (Cs/C,) as a function of fraction solidified (fs) for Pb-6Sh grown
at (a) 10.4 um/s (b) 63.1 um/s and corresponding log(Cs/C,) as a function of log (1-fs) for Pb-6Sh grown at
(a) 10.4 um/s (b) 63.1 um/s

A Cs/C, value of 1 suggests an absence of convection and therefore no
macrosegregation. Figure - 14 (a) and (b) shows negative macrosegregation or Cs/Co < 1
initially until about 75% of the specimen grown at both 10.4 and 63.1 pm/s were solidified.
Positive macrosegregation or Cs/Co > 1 is observed as both specimen reach complete
longitudinal solidification (fs =100%). The increasing trend for longitudinal
macrosegregation was expected. As the liquid cools, the alpha phase dendrite of mostly Pb
continuously rejects excess Sb and the remaining liquid becomes slightly richer in Sb as
indicated by the liquidus line on the Pb-Sb phase diagram. The composition of the solid
alpha phase also becomes slightly richer in Sb atoms as the solid solution line shows.

The effective partition coefficient, ke, obtained by fitting experimentally observed
macrosegregation to Cs/Co = ke (1- fs) *® 1 is a good indicator of the extent of convective
mixing during directional solidification.'® Figure - 14 (c) and (d) plots the log(Cs/Co) as a
function of log (1-fs) for the data shown in Figure -14 (a) and (b), respectively. The
observed macrosegregation data shows a good fit to the established relationship. Average
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ke values obtained from the slope and that from the intercept for the specimen grown at
10.4 and 63.1 um/s are 0.94+0.11 and 0.91+0.08, respectively. This suggests that a
stronger convection may be present in the specimen grown at a lower growth speed.

3.1.3. Primary Dendrite Trunk Diameter Dependence on Growth Speed and

Distance From the Base

The average trunk diameter values after solidification at several transverse
locations were determined using the measured trunk diameter from transverse images at
each corresponding locations. The dependence of average primary dendrite trunk diameter
on distance from the base of the directionally solidified specimens with constant cross

section grown at 10.4 and 63.1 um/s are plotted in Figures - 15 (a) and (b), respectively.
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Figure 15 Average primary dendrite trunk diameter as a function of location for Pb-6Sb grown at (a) 10.4
pum/s (b) 63.1 pum/s

The mean trunk diameter decreases as the distance from the base increase. This is
indicative of the longitudinal macrosegregation due to thermo-solutal convection. The
mean trunk diameter also decreases with increasing growth speeds. The results using the
trunk diameter prediction model by Tewari et. al are also plotted in Figures - 15 (a) and
(b).X® The figures indicate that there is a good agreement between the model and
experimental data even though the experimental data is consistently greater compared to
the predicted values.

3.1.4. Nearest Neighbor Spacing Dependence on Growth Speed and

Distance From the Base

Nearest neighbor spacing (n.n. spacing) at various locations were calculated using

the measured dendrite centers from transverse images at each corresponding locations. The

n.n. spacing for specimens with constant cross section grown at 10.4 and 63.1 um/s are
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plotted in Figures - 16 (a) and (b), respectively. The figures suggest increasing growth
speed decreases n.n. spacing. The Hunt-Lu model allows for the calculation of primary
spacing in a steady state growth system of dendrites in a moving linear temperature field
as a function of distance.*!8 The observed n. n. spacing in both specimens grown in 10.4
and 63.1 um/s growth speeds decrease as the distance from the base increases. The
observed n. n. spacing values are also consistently lower than the predicted values for both
specimens grown at 10.4 and 63.1 um/s.
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Figure 16 Nearest neighbor spacing as a function of location for Pb-6Sb grown at (a) 10.4 um/s (b) 63.1
pm/s

3.2. Effects of Cross-section Contraction in Pb-6 % Sb (Solutally Unstable) vs.

Al-19 % Cu (Solutally Stable) Systems

3.2.1. Longitudinal and Transverse Macrostructure Images

A longitudinal section through the Pb-6 % Sb specimen near the cross section
contraction point (from 12.7 to 6.35 mm sample diameter) is shown in Figure - 17. This
sample is solidified at a low growth speed of 11.5 um/s. The hot end of the sample is
indicated by an arrow on the bottom left of the longitudinal section. A “eutectic” only
region at the shelf-top immediately prior to the cross-section decrease can be observed.

Some of the primary o dendrites appear to continue on through the section decrease.
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Figure 17 Longitudinal macrostructure of Pb-6Sh grown at 11.5 pm/s with cross section contraction.
(Diameter decrease from 12.7 mm to 6.35 mm)

Figure - 18 (a) shows the transverse images before and after contraction
corresponding to the Pb-6 % Sb specimen seen in Figure - 17. Figure - 18 (b) shows the
transverse images before and after contraction for Al-19% Cu grown at 11.5 pm/s from a
previous study conducted by Masoud et. al.}' Negative distances represent transverse

locations before the contraction and positive distances indicate transverse locations after

contraction.
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Figure 18 Transverse macrostructure of (a) Pb-6Sb grown and (b)AI-19Cu'! at 11.5 um/s with cross section
contraction.

Radial macrosegregation is observed in Al-19 % Cu which is not present in the Pb-
6 % Sb transverse macrostructure image. Some of the primary o dendrites appear to
continue on through the section decrease for both Pb-6 % Sb and Al-19 % Cu. Within the
core, immediately after contraction, the transverse and longitudinal images for Pb-6% Sb
show primarily dendrite o phase and the channels which also appear to continue on through
the section decrease. Channel flow in the liquid is likely to cause remelting and possible
stray grain formation as observed in the misaligned dendrites immediately after contraction
on the right side of the smaller diameter section as seen in Figure - 17. The presence of
steepling convection in Al-19 % Cu is suggested from the eutectic—only region observed

in the transverse image right before contraction. Steepling seems to disappear immediately
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after contraction but should be noted that it re-establishes itself about +13 mm above the
point of contraction.” !

As the mushy-zone approaches contraction, the solute at the array tips gets
accumulated on the top-shelf around the sample periphery causing solute accumulation
before the cross-section change. Shrinkage flow from the smaller section is anti-parallel to
the primary dendrite arms at the center of the section and may diverge towards the outer
radius in the larger section. Radial macrosegregation can, therefore, be observed right
before contraction for Pb-6% Sb due to solidification of entrapped solute-rich liquid as
seen in Figure -17.

3.2.2. Comparison of Longitudinal Macrosegregation in Pb-6% Sb vs. Al-

19% Cu Directionally Solidified with Cross-section Contraction

Measurements of f5 in several transverse sections along the specimen length, before
and after the contraction, were used to determine the solute concentration at each
predetermined locations. The equations discussed in Sec. 3.13.2 were used to determine Sb
concentration for Pb-6% Sb For Al-19% Cu, C,., = 4.408 + 28.86f; was used® Figure-19
(a) illustrates the measured concentration of Sb and the general trend in the absence of a

Cross section contraction.
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Figure 19 Longitudinal macrosegregation (%Solute) as a function of distance from contraction for (a) Pb-6
Sb and (b) Al-19Cu**

The gradual increase in concentration along the DS length suggests the presence of

thermo-solutal convection allowing solute-rich interdendritic fluid to mix with the bulk
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melt ahead of the mushy zone in Pb-6% Sb. This is seen in both the specimens where there
IS a presence of contraction and also where there is a uniform cross-section along the length.
This is not seen in the experiments run by Masoud et. al for Al-19% Cu in the presence of
contraction where there is minimal longitudinal macrosegregation as seen in Figure - 19
(b).X! For both Pb-6% Sh and Al-19% Cu systems, a solute build-up is seen just before the
contraction, which is followed by a sharp decrease just after the contraction. The solute
content then slowly recovers after the contraction. This trend is supported by the
longitudinal image shown in Figure - 17. This is because of the solute rich liquid ahead of
the mushy-zone array getting trapped below the beginning of contraction on the ceilings in
the mold below around the outer periphery.

3.2.3. Comparison of Primary Dendrite Trunk Diameter in Pb-6% Sb vs.

Al-19% Cu Directionally Solidified with Cross-section Contraction

Figure - 20 (a) shows the primary dendrite trunk diameter dependence on distance
from the cross-section contraction for Pb-6% Sb. The plots also show the predicted trunk
diameter using Tewari et al. model.*® Experimental and predicted data for trunk diameter
in Al-19 % Cu were obtained from Masoud et. al previous study and plotted in Figure - 20

(b) below. !
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Figure 20 Average primary dendrite trunk diameter as a function of distance from contraction for (a) Pb-
6Sb and (b) Al-19Cu*t

The average trunk diameter for Pb-6% Sb is observed to decrease over the entire
length of the sample. This is indicative of the longitudinal macrosegregation caused by the
presence of strong plume-type thermosolutal convection in the melt. This trend is not seen
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in the Al-19% Cu, where the trunk diameter remains relatively constant over the length of
the specimen through a contraction. Right at the contraction, the area-change-driven
shrinkage flow slightly decreases the trunk diameter for Pb-6% Sb. The measured trunk
diameter is consistently larger than the predicted values for Pb-6% Sb but fits the model
very well in the Al-19% Cu.

3.2.4. Comparison of Nearest Neighbor Spacing in Pb-6% Sb vs. Al-19%

Cu Directionally Solidified with Cross-section Contraction

The dependence of nearest neighbor spacing (n.n. spacing) on distance from the
contraction was plotted for Pb-6% Sb in Figure-21 (a). Predicted n.n. spacing values were
calculated using Hunt-Lu model also shown in the plots below.*'® Experimental and
predicted data for n. n. spacing values for Al-19 % Cu were obtained from Masoud et. al

previous study and plotted in Figure - 21 (b) below.!
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Figure 21 Nearest neighbor spacing as a function of distance from contraction for (a) Pb-6Sb and (b) Al-
19Cut

The experimental n. n. spacing values for both Pb-6% Sb and Al-19% Cu are
consistently lower than the model calculations. At the contraction, the predicted n.n.
spacing in the Pb-6% Sb shows an increase that is not seen in the experimental data. There
is a slight decrease in the measured n. n. spacing starting from about -20 mm before the
contraction which quickly increases back at about 10 mm after contraction. Area-change-
driven shrinkage flow has a more observable effect on the n.n. spacing close to the

contraction point for Pb-6% Sb that Al-19% Cu.

3.3. Effects of Cross-Section Expansion in Pb-6% Sb (Solutally Unstable) vs. Al-
19% Cu (Solutally Stable) Systems

3.3.1. Longitudinal and Transverse Macrostructure Images
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A longitudinal section through the Pb-6% Sb specimen near the cross section
expansion point (from 6.35 mm to 12.7 sample diameter) is shown in Figure - 22. Primary
a phase fills the diameter immediately following the expansion. Some of the primary o
dendrites from the smaller cross section region appear to continue on through the section
increase. New dendrites formed in the expanded region also grew in alignment with the
existing core dendrites. There are no misaligned dendrites observed in the reentrant of the
cross-section expansion. This is very different than Masoud et. AlI'! observation in Al-
19%Cu alloy where extensive new grain formation was observed on the expansion

platform above.

INAARNERR

Figure 22 Longitudinal macrostructure of Pb-6Sh grown at 8.7 um/s with cross section expansion.
(Diameter increase from 6.35 mm to 12.7 mm)

Figure 23 (a) shows the transverse images before and after expansion corresponding
to the Pb-6 % Sb specimen seen in Figure - 22. Figure - 22 (b) shows the transverse images
before and after contraction for Al-19% Cu grown at 10 um/s from a previous study
conducted by Masoud et. al.*! It is evident that in Pb-6% Sb alloy no new grains were
formed whereas extensive “spurious grains” were observed to form in Al-19% Cu alloy
samples. It may be because the dendrite fragments resulting from the localized convection
induced solutal-remelting of slender side-branches which act as nuclei for the formation of
potential spurious grains are denser than the surrounding liquid melt in the case of Pb-6%
Sh alloy and therefore sink and get entrapped in the growing dendrite network. This may

not be the case with the Al-19% Cu alloy, where the broken primary a-phase dendrite
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fragments have a lower density than the surrounding melt. Hence, they float and depending

upon the local thermal conditions some of them may grow into new misoriented grains.

@ (b)

Figure 23Transverse macrostructure of (a) Pb-6Sb grown at 8.7 um/s and (b)Al-19Cu'! at 10 pm/s with
Cross section expansion.

3.3.2. Longitudinal Chemical Inhomogeneity

Longitudinal macrosegregation in Pb-6% Sb grown at 8.7 um/s as a function of
distance from the cross section expansion is plotted in Figure - 24 (a). The gradual increase
in Sb concentration is indicative of the presence of convection. The expected trend in the
absence of an expansion is also plotted in Figure - 24 (a) with a dashed line. The slope of
the expected trend in the larger cross section area is steeper than that in the smaller cross
section area prior to expansion. This suggests that there is more macrosegregation in the
larger cross section area after expansion than in the smaller cross section before. There is

slight positive macrosegregation just before the cross section expansion as seen from the
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experimental data. The reason for this behavior is not clear at this stage. It may have
something to do with the weakening of the down-wards “solidification shrinkage” flow in
this region. There is a negative macrosegregation immediately after the expansion because
the side-branches of primary dendrites growing sideways and filling the platform above do
not allow solute accumulation on the platform, the solute rejected by solidification is
instead transported and mixed in the liquid column above. This spread of solute poor
primary o phase which solidified on the re-entrant shelf in the larger cross section region

above is evident in the longitudinal microstructure image shown in Figure - 22.
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Figure 24 Longitudinal macrosegregation (%Solute) as a function of distance from expansion for (a) Pb-6
Sb and (b) Al-19Cu**

Figure - 24(b) shows the plot for longitudinal macrosegregation for Al-19 % Cu
grown at 8.7 um/s as a function of distance from the cross section expansion as obtained
results from a previous study.!! Because in Al-19%Cu alloy the solute in the mushy-zone
does not mix with the melt column above there is no longitudinal macrosegregation along
the sample length. Average solute content along the sample length remains relatively
unaffected by the section-change, except for the negative macrosegregation seen at the
expansion platform above for the same reason as in the Pb-6%Sb alloy, the sideways spread

of side-branches of primary dendrites.

3.3.3. Primary Dendrite Trunk Diameter
Experimental and predicted primary dendrite trunk diameter results are plotted

below for Pb-6% Sb (Figure - 25 (a)) and Al-19% Cu (Figure - 25 (b) was obtained from
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Masoud et al results) grown at 8.7 um/s as a function of distance from cross-section
expansion.t! The measured data for Pb-6% Sb are consistently larger than the predicted
values. Since some of the primary o dendrites from the smaller cross section region appear
to continue on through the section increase (Figure - 22), cross-section expansion had little
effect on trunk diameter measurements unlike in contraction. The resulting experimental
trunk diameter for Al- 19% Cu seem to fit the predicted model well. This maybe in part
due to the fact that convection in Al-19% Cu occurs radially and therefore might be

minimized longitudinally.
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Figure 25 Primary dendrite trunk diameter as a function of distance from expansion for (a) Pb-6 Sb and (b)
Al-19Cult

3.3.4. Nearest Neighbor Spacing

The experimental and predicted primary dendrites nearest neighbor spacing for Pb-
6% Sb and Al-19% Cu results from the previous experiment are plotted in Figure - 26 ()
and (b), respectively as a function of distance from expansion.'* In both systems, the
measured nearest neighbor spacing is lower than the predicted values from the Hunt-Lu
equation. A slight decrease in spacing can also be noted after expansion for both Pb-6% Sb
and Al-19% Cu. This may have been caused by area-change-driven shrinkage flow that is

not as intensified in expansion as it is in a contraction abrupt change.
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CHAPTER IV
CONCLUDING REMARKS

In summary, Pb-6% Shb alloy cylindrical samples were directionally solidified in 9
mm diameter constant cross-section mold and also in molds having an abrupt cross-section
decrease (from 9-mm to 3.2 mm) and also an abrupt cross-section increase (from 3.2 mm
to 9-mm) for growth 10.4, 63.1., 11.5 and 8.7 um/s growth speeds, respectively. This alloy
system is susceptible to “plume type” of thermosolutal convection because of the solute-
concentration induced melt density inversion in the interdendritic melt in the mushy zone.
Mushy zone morphology along the length of the samples was metallographically examined
and analyzed using quantitative image-analysis techniques. The longitudinal and radial
chemical inhomogeneities (macrosegregation) were measured on several transverse
sections along the sample length. Primary dendrite nearest neighbor spacing and primary
dendrite trunk diameters were also measured on these transverse sections. The
experimental observations were compared with those made by Masoud et. al'! in Al-
19%Cu alloy which is not susceptible to “plume type” of thermosolutal convection.
Instead, it is susceptible to “Steepling type” of thermosolutal convection. Following

conclusions can be made from this study.



In the constant cross-section samples,

1.

In the directionally solidified Pb-6% Sb alloy, the experimentally measured
primary dendrite trunk diameter values are higher than those predicted from
theoretical models which do not take convection into account. This is not the case
with Al-19% Cu alloy.

In the directionally solidified Pb-6% Sb alloy, the experimentally measured
primary dendrite nearest neighbor spacings are lower than those predicted from
theoretical models which take only diffusive transports into consideration. This is
also the case with the Al-19% Cu alloy.

Longitudinal macrosegregation caused by convective mixing of the interdendritic
mushy zone melt with the bulk melt above is observed in the Pb-6% Sb alloy
samples. The Al-19% Cu alloy samples did not show any longitudinal
macrosegregation.

It appears that the slower growth speed results in more convective mixing and thus
a slightly larger extent of longitudinal macrosegregation (slope of log(Cs/Co) vs.

log(1-fs)) in Pb-6%Sb alloy.

In the Cross-section change samples,

1.

For the abrupt cross section area decrease, both solutally stable (Al-19% Cu) and
unstable (Pb-6% Shb) alloy samples showed an increase in macrosegregation due to
the solute rich liquid ahead of the solidifying mushy zone below getting entrapped
at the bottom of the expansion shelf just before the cross section change. This is
followed by a solute concentration decrease after the section change, possibly

because of the solidifying shrinkage fluid flow intensifying as the liquid-solid



interface approaches the section decrease.

2. For the abrupt cross-section area increase, there is a solute depletion just ahead of
the section change because in this region the primary dendrite arrays emerging from
below shoot-off side-branches which grow side-ways and fill the larger cross-
section platform above. This spreading primary a-phase spreading on the platform
above is solute poor. This is observed in both Pb-6% Sb and in Al-19% Cu alloy.

3. Al-19% Cu alloy sample showed extensive spurious grain formation on the
platform above in the samples solidifying through an abrupt area increase. This is
not the case with Pb-6% Sb alloy samples. It may be because the dendrite fragments
resulting from the localized convection induced solutal-remelting of slender side-
branches which act as nuclei for the formation of spurious grains are denser | than
the surrounding liquid in the case of Pb-6% Sb alloy; which is not the case with the

Al-19% Cu alloy.
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CHAPTER V
RECOMMENDATIONS FOR FUTURE RESEARCH

1. Samples with a varying cross-section ratios should be examined to examine the role of
section-change induced solidification shrinkage flow on the macrosegregation and
dendritic array microstructure. Also samples with gentler cross-section change should
be grown and studied.

2. Arange of different alloy compositions and alloy systems need to be examined in order
to better understand the role of alloy thermophysical properties.

3. Low-g experiments are required to isolate the “area-change induced” shrinkage flow
and gravity driven thermosolutal convection flows on the dendritic array morphology

and macrosegregation.
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APPENDIX A
TRUNK DIAMETER AND NEAREST NEIGHBOR SPACING MATLAB CODE

CALCULATIONS USING EXPERIMENTAL DATA

clc; clear all

ExcelFile= uigetfile;

raw=xlsread (ExcelFile); %% the numerical values in a matrix called raw
[r c]l=size (raw); % r is number of rows and ¢ is number of columns in
data excel file

scale=2420; % number of pixels per mm in original image

oo
oo
o\

the for loop scans pairs of line in "raw" matrix
for n=1:r/2

[

% this if takes care of the regular drawn lines. The sixth element
of

% each row is the angle and decision about the use of BX and BY as
a known point

o)

% on the drawn line is based on this angle wvalue

if ((raw(2*n-1,6)<0) && (raw(2*n-1,6)> -90)) || ((raw(2*n-1,6)> 90)

&& (raw(2*n-1,6)< 180))

Xl=raw (2*n-1,2);

Yl=raw(2*n-1,3)

X2=raw (2*n,2) ;

Y2=raw (2*n, 3)+raw(2*n,5) ;

ml=-tand(raw (2*n-1,6));

m2=-tand (raw (2*n, 6)) ;

X=(ml*X1-Y1+Y2-m2*X2)/ (ml-m2) ;

Y=ml* (X-X1)+Y1l;

TD=(raw (2*n-1,7)+raw (2*n,7))/2/ (scale/1000) ;

’

else if ((raw(2*n-1,6)<90) && (raw(2*n-1,6)> 0)) || ((raw(2*n-1,6)>

-180) && (raw(2*n-1,6)< =90))

Xl=raw (2*n-1,2);

Yl=raw (2*n-1,3)+raw(2*n-1,5) ;

X2=raw (2*n,2);

Y2=raw (2*n, 3);

ml=-tand(raw (2*n-1,6));

m2=-tand (raw (2*n, 6)) ;

X=(ml*X1-Y14+Y2-m2*X2)/ (ml-m2) ;

Y=ml* (X-X1)+Y1;

TD=(raw (2*n-1,7)+raw (2*n,7))/2/ (scale/1000) ;

end

(3]

%%%%%% special cases start here $%%%%%%%
% this if makes decision about the use of BX and BY in case the
first line in a pair is vertical

[

% and the second one is either in first or in third quadrant
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if ((raw(2*n-1,6)== 90) || (raw(2*n-1,6)== -90)) &&
(((raw(2*n, 6)<90) && (raw(2*n,6)> 0)) || ((raw(2*n,6)> -180) &&
(raw (2*n,6)< =-90)))

X2=raw (2*n,2);

Y2=raw (2*n, 3)+raw(2*n,5);

m2=-tand (raw(2*n, 6) ) ;

X=raw (2*n-1,2);

Y=m2* (X-X2)+Y2;

TD=(raw (2*n-1,7)+raw(2*n, 7)) /2/ (scale/1000) ;

end

o)

% this if makes decision about the use of BX and BY in case the
first line in a pair is vertical

% and the second one is either in forth or in second gquadrant

if ((raw(2*n-1,6)== 90) || (raw(2*n-1,6)== -90)) &&
(((raw(2*n, 6)<0) && (raw(2*n,6)> -90)) || ((raw(2*n,6)> 90) &&
(raw (2*n,6)< 180)))

X2=raw(2*n,2);

Y2=raw (2*n, 3);

m2=-tand (raw (2*n, 6)) ;

X=raw(2*n-1,2);

Y=m2* (X-X2)+Y2;

TD=(raw (2*n-1,7)+raw (2*n,7))/2/ (scale/1000) ;

end

% this if makes decision about the use of BX and BY in case the
first

o

line in a pair is horizontal
and the second one is either in first or in third quadrant
if ((raw(2*n-1,6)== 0) || (raw(2*n-1,6)== 180)) &&
(((raw(2*n,6)<90) && (raw(2*n,6)> 0)) || ((raw(2*n,6)> -180) &&
(raw (2*n, 6)< -90)))
X2=raw (2*n,2) ;
Y2=raw (2*n, 3)+raw(2*n,5) ;
m2=-tand (raw(2*n, 6) ) ;
Y=raw (2*n-1,3);
X=(Y-Y2) /m2+X2;
TD=(raw(2*n-1,7)+raw(2*n,7))/2/ (scale/1000) ;
end

o

% this if makes decision about the use of BX and BY in case the
first

% line in a pair is horizontal

% and the second one is either in forth or in second quadrant

if ((raw(2*n-1,6)== 0) || (raw(2*n-1,6)== 180)) && (((raw(2*n,6)<0)
&& (raw(2*n,6)> =-90)) || ((raw(2*n,6)> 90) && (raw(2*n,6)< 180)))

X2=raw(2*n,2);

Y2=raw (2*n, 3) ;

m2=-tand (raw (2*n, 6)) ;

Y=raw(2*n-1,3);

X=(Y-Y2) /m24+X2;

TD=(raw (2*n-1,7)+raw(2*n,7))/2/ (scale/1000) ;

end

o)

% this i1f makes decision about the use of BX and BY in case the
first
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% line in a pair is horizontal

% and the second one is vertical

if ((raw(2*n-1,6)== 0) || (raw(2*n-1,6)== 180)) && ((raw(2*n,6)==
90) || (raw(2*n,6)== -90))

X=raw(2*n,2);

Y=raw (2*n-1,3);

TD=(raw (2*n-1,7)+raw(2*n,7))/2/ (scale/1000) ;

end

% this if makes decision about the use of BX and BY in case the
first

o

line in a pair is vertical

% and the second one is horizontal

if ((raw(2*n-1,6)== 90) || (raw(2*n-1,6)== -90)) && ((raw(2*n,6)==
0) || (raw(2*n,6)== 180))

X=raw(2*n-1,2);

Y=raw(2*n, 3) ;

TD=(raw(2*n-1,7)+raw(2*n, 7)) /2/ (scale/1000) ;

end

% putting the calculated X and Y corresponding to center of
dendrite

% and its trunk diameter in proper place in result matrix
result (n, 2)=X;
result (n, 3)=Y;
result(n,4)=TD;

end

% this loop calculates NNS, 3NNS and 6NNS based on calculated X and Y
of each dendrite
% it starts from the first point in the table and calculates the
distances from that point to all other poins, then sorts
% the distances vector and select the first element as NNS, mean of
first
% three as 3NNS and mean of first six as 6NNS
for i=1l:x/2
z=1;
for j=1l:r/2
if i~=3 %
distance (z)=sqgrt ((result(i,2)-(result(j,2))) "2+ (result (i, 3)-
(result(3,3)))"2);
z=z+1;
end

end

distance=sort (distance);

NNS (i1)=distance (1) ;

NNS3 (i) =mean (distance (1:3));

NNS6 (i) =mean (distance (1:6)) ;

end
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% converting spacings to micro meter
NNS=(NNS./ (scale/1000))"';
NNS3=(NNS3./ (scale/1000))"';

NNS6= (NNS6./ (scale/1000))"';

if (x/2)>= 15

NNS s=sort (NNS) ;

topl0 NNS avg=mean (NNS s (l:round((r/2)/10)));

topl0 NNS std=std(NNS_ s (l:round((r/2)/10)));

bottl0 NNS avg=mean (NNS_ s (length (NNS s)-round((r/2)/10)+1l:end));
bottl0 NNS std=std(NNS s (length(NNS_ s)-round((r/2)/10)+1l:end));

TD=sort (result(:,4));

topl0 TD avg=mean (TD(l:round((xr/2)/10)));

topl0 TD std=std(TD(l:round((r/2)/10)));

bottl0 TD avg=mean (TD(length (TD)-round((r/2)/10)+1l:end));
bottl0 TD std=std(TD(length(TD)-round((r/2)/10)+1l:end));

end

% calculating the mean and standard deviation on spacing for the whole
data

% set

NNS Mean=mean (NNS) ;

NNS STD=std (NNS) ;

NNS3 Mean=mean (NNS3) ;

NNS3 STD=std (NNS3) ;

NNS6 Mean=mean (NNS6) ;

NNS6_ STD=std (NNS6) ;

% putting calculated spacings in the results table

result (:,5)=NNS;

result (:,6)=NNS3;

result (:,7)=NNS6;

result(:,1)=1:r/2; % filling the first column of result table with
dendrites numbers

% creating output excel file

filename = 'XY TD PDAS.xlsx';

A = {'Dendrite No.',6 'Dendrite Center X', 'Dendrite Center Y', 'Dendrite
TD(um) ', 'Dendrite NNS (um) ', 'Dendrite 3 NNS (um) ', 'Dendrite 6 NNS (um)'};
xlswrite (filename,A, 1)

x1Range = 'E1';

xlswrite (filename, result,1, 'A2")

if (r/2)>= 15
B={'TD mean', 'TD std', '"NNS mean', 'NNS std', ...
'Top 10% TD avg', 'Top 10% TD std', 'bottom 10% TD avg', 'bottom
10% TD std', ...
'Top 10% NNS avg', 'Top 10% NNS std', 'bottom 10% NNS
avg', '"bottom 10% NNS std'};
xlswrite(filename,B, 1, 'J3")
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xlswrite (filename, [mean (result(:,4)),std(result(:,4)),mean(result(:,5))
,std(result(:,5)),...
topl0 TD avg,toplO0 TD std,bottl0 TD avg,bottl0 TD std...
toplO NNS avg,topl0 NNS std,bottl0O NNS avg,bottl0 NNS std],1,'J4")
else
B={'TD mean', 'TD std', 'NNS mean', 'NNS std'};

xlswrite(filename,B, 1, 'J3")

xlswrite (filename, [mean (result(:,4)),std(result(:,4)),mean(result(:,5))
,std(result(:,5))],1,'J4")

end
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APPENDIX B

TRUNK DIAMETER AND NEAREST NEIGHBOR SPACING MATLAB

CODE MODEL PREDICTION CALCULATIONS

clc;
[z zz]=size (data);
for i=l:z
%$%% Al 19Cu Properties
% m=-3.3429; S%K/wt%
% Tm= 663.79+273.15; % K Linearized Pure Al Melting Point
% TE= 548+273.15; % K
% T1=605.45+273.15;
% k=0.1203;
% D1=5388; % um”™2/s
% Gamma=0.1976; % K*um

oe

%$%% Al 7-Si Properties
m=-6.9468; %K/wt
Tm= 673+273.15; %
TE= 577+273.15; %
T1=620+273.15; % K

oe

o

Linearized Pure Al Melting Point

o o oe

oe

k=0.1273;
D1=5409; % um”2/s
Gamma=0.1702; % K*um

o° oo oe

oe

% Co=7; % %

% V=data(i,1l); % um/s

% Gl=data(i,2); % K/cm
% Gm=data (i, 3); % K/cm

%%%% Pb-6 Sb Properties
m=-6.78; SK/wt
Tm= 327.5+273.15;
TE= 252.2+273.15;
T1=288.18+273.15;

oe

K Linearized Pure Al Melting Point
K
K

o\°

o\°

k=0.31;
D1=1130; % um™2/s
Gamma=0.105; % K*um

V=60; % um/s

Co=data(i,1); % %

Gl=data(i,2); % K/cm

Gm=data (i, 3); % K/cm
©900000000000000000000000000000000000000000000000
OO0OOOOOODOOODODOOODODODODODODODODODODODODODODODODODODODODODODODODODODODODODOODO©OO™©

G1=G1*100; %K/m
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Gm=Gm*100; %K/m
V=V*10"-6; %m/s

Gamma=Gamma*10"-6; %$K*m
D1=D1*10%-12; % m"2/s

delTo=m*Co* (k-1) /k;
V_=V*Gamma*k/ (Dl*delTo) ;
G =Gl*Gamma*k/ (delTo) "2;

s=1-G _/V_;

%% Primary Dendrite Arm Spacing
a=-1.131-0.1555*10g10(G )-0.758%e-2* (1logl0(G ))"2;
lambda =0.7798e-1*V_"(a-0.75)*(V_-G )"0.75*G_"(-0.6028);

lambda=lambda *Gamma*k/delTo;
lambda*2*10"6

%% Tip Undercooling

.734+5.930%10g10 (k) +0.2578* (1og10 (k) ) *2;
.4307-0.1656e-3*10g10 (k) -0.04455% (10g10 (k)
.454+0.2735%10g10 (G_)+0.04145% (10g10(G_))"
+0.001882* (1og10 (G_)) "3;

delT s=(G_/V_) " c+a*V_“b+(l-a)*V_*(1.2%Db);

)25
2....

OCI)I“QJ
— O

delT c¢=0.41*(V_-G )"0.51;
delT tip=(delT s+delT c) *delTo;
%% Tip Radius

R tip=2*Gamma/ (delT c*delTo) ;
R tip*1076

%% Tip Composition in the solid

Ct=(delT s*delTo+delTo/ (1/k-1))/ (-m/k);
% ((Tl-delT tip-Tm)/m)*k

%% Trunk Diameter

Tf=(T1-TE) - (Ct/k—-Co) * (-m)

t=(Tf)/ (Gm*V) % freezing time

to=22*R _tip/V;

TDo=6.59*R_tip;

TDo*10"6

TD=(96*D1*Gamma/ (V*Gm* (1-k)) *log ( (1+V*Gm*t/ (-m*Co) ) / (1+V*Gm*to/ (-
m*Co) ) )+TDo"3) "~ (1/3);

TD*10"6
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end

o\

(delTo-delT tip)/ (Gm*V)

o\

o

Tt=T1-(D1*Gm/V) ;
(Tt-TE) / (Gm*V)

o

Result (i,1)=s;
Result (i, 2)=R tip*10°6;
Result (i, 3)=Ct;

Result (i,4)=lambda*2*10"6;
Result (i,5)=Tf;
Result (i, 6)=t;
Result (i, 7)=TD*10"6;
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APPENDIX C
DETAILED PROCEDURE FOR FRACTION EUTECTIC DATA
EXTRACTION
. Go to File — Open- Select the Image of the sample
If image is not 8-bit already

a. Image- Type- 8-bit

. Select the wand tool

a. Find the value of the higher white values in the sample by hovering mouse
|
File Edit Image Proce:
o) z|o|~£|4

x=4416, y=7424  value=251
over that area and reading the value as shown below

-
F

b. Double click the wand tool and set your tolerance to some number slightly
below this value
c. Click OK once tolerance is chosen

d. With the wand tool selected click within your sample and it should select

i

Tolerance: 4 | | [240
Mode: |Legacy ]

[ Enable Thresholding

Thresholded objects are traced and "Tolerance"
is ignored when thresholding is enabled.

OK | Cancel

the perimeter of your sample

i. Note two different problems
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1. If the color of wand tool is set to black you will be unable to
see the selection

a. Double-click the point tool and change the color to

+++
& B

ot
Type: m
Color: [Yellow ~]

Size: [small ~|

Iv Label points
v Show all

Counter: [0 |

0

0K | Cancel| He|p|

yellow if this problem is occurring

2. Another error is the Region selected by the wand tool could
go into the sample some, which can be adjusted two ways
a. Lower the tolerance of the wand tool

3. Could also manually draw srme of the perimeter lines with

-
3

the Paintbrush tool
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4. With your sample region selected go to Analyze- Tools- ROl Manager

5. Click Add [t] which adds this selection to the ROl Manager

6. Deselect this region by selecting the Rectangle Tool D and clicking anywhere
on the picture file

7. Image- Adjust- Threshold

¢ Threshold X

44.94%
LI J 4" 181
K| 1] 255

[Defautt v| [Baw |
[¥ Dark background [ Stack histogram

M Apply | Reset ﬁl

[TV

Delete
Rename...

Measure

Deselect

Properties...
Flatten [F]

More »
I~ Show All
|= [ Labels

8. Use the default method and click apply

a. Can be manually adjusted due to quality of the image (primarily shadowing)

by selecting the color of the dendrites (with the color picker tool ’ ) and

manually filling them in with the brush tool

9. Next step is to remove the inverting LUT
i

23392x23144 pixels; B-bit (inverting LUT); 516MB
a. Image- Lookup Tables- Invert LUT

b. Edit- Invert
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I. This makes alpha phase black and have a value of zero and image

23392x23144 pixels, 8-bit, 516MB

should look like this
10. Next remove the scale in the bottom right corner if there is one
a. Rectangle tool the region with scale and fill with white
11. Important to now save image as a different file than the original image

a. File- Save as- .tiff
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12. Process- Binary- Watershed

SR -

LI
4

13. Now you need to get rid of the alpha phase in the eutectic region
a. Find a large particle in eutectic region
b. Select the wand tool with a threshold of 1
c. Select that particle

d. Analyze- Set Measurement- Area

Set Measurements X

¥ Areal I~ Mean gray value
I Standard deviation | Modal gray value
I~ Min & max grayvalue | Centroid

I~ Center of mass [ Perimeter

I~ Bounding rectangle [ Fitellipse

I” Shape descriptors [ Ferets diameter

I Integrated density ™ Median
[~ Skewness ™ Kurtosis
I~ Areafraction I~ Stack position

I™ Limitto threshold [ Display label
I~ InvertY coordinates |~ Scientific notation
I Add to overlay [ NaN empty cells

Redirectto: |None |

Decimal places (0-9). |1

oK ‘ Canf:e\| He|p|

e. Analyze Measure (control M)

f. Deselect that particle to make sure you have entire picture in selection
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g. Analyze- Analyze Particles
I. Size: 0-“Number slightly higher than area of the particle selected”

ii. Show: Masks

-f Analyze Particles *

Size (pixel*2). |0-3550

Circularity: |0.00-1.00

Show:; ||".I|E.SK5 v|

™ Exclude on edges

I Include holes
[~ Summarize ™ Record starts
[~ AddtoManager [ Insitu Show

0K | Cancell Help|

h. Click OK
14. New Image will open
15. Edit- Selection- Create Selection
a. Add to ROI Manager
b. Close the newly created window
16. Click on the ROI you just created to selected it
a. Select white with the color picker tool
b. Edit- Fill
i. Or control F

17. Select original ROI (boundary of your sample)
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18. Analyze-Set Measurements- Mean Gray Value

¢ Set Measurements X

[~ Area :
[~ Standard deviation |~ Modal gray value
[ Min & max grayvalue | Centroid

™ Center of mass [~ Perimeter

I~ Bounding rectangle [ Fitellipse

[ Shape descriptors |~ Feret's diameter
I Integrated density [~ Median

™ Skewness [~ Kurtosis

[~ Area fraction [ Stack position

™ Limitto threshold [~ Display label
™ InvertY coordinates [~ Scientific notation
[~ Addto overlay [~ NaN empty cells

Redirect to: |None j

Decimal places (0-9): (1

OK | Cancel | Help

a. Analyze- Measure
i. Or control M

19. Divide the number you get by 255 to get fraction eutectic
20. These next steps are not always necessary but can help get a better fraction eutectic
21. Process-Binary- Dilate
22. Process- Binary- Erode
23. Measure the Mean gray value and divide by 255 to get fraction eutectic

a. The reason you typically don’t need this step is because the value difference

is so small as seen below

* Results — [l >
File Edt Font Results

Mean

1 1201
2 1494

78



APPENDIX D
DETAILED PROCEDURE FOR NEAREST NEIGHBOR SPACING AND TRUNK

DIAMETER DATA EXTRACTION

1. Open Program ImageJ
2. File-Open-Select Image of sample
3. Analyze-Set Measurements-Bounding rectangle

¢ Set Measurements X

[“iAreal ™ Mean gray value
[~ Standard deviation [~ Modal gray value
[~ Min & max grayvalue [~ Centroid

[ Center of mass I~ Perimeter

[¥ Bounding rectangle [ Fitellipse

[~ Shape descriptors [ Feret's diameter
[ Integrated density ™ Median

[~ Skewness ™ Kurtosis

[ Area fraction [ Stack position

[~ Limitto threshold I Display label
[ Invert Y coordinates [~ Scientific notation

[~ Addto overlay [~ NaN empty cells
Redirect to: |Nune -

Decimal places (0-9): |3

OK | Cancell Helpl

4. Double click color picker tool 7’ ‘ - Select black

~
5. Double click straight tool —*_ and make line width approximately 10

4 Line Width X

<] | [1df [ Spline fit
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6. Make X’s on the dendrites to get the enter and trunk diameter
r SR kT 3

7. Control F is fill line and control M is measure

8. Copy all the line data from ImageJ into Excel and save
9. Open program MATLAB

10. Run MATLAB script XY_TD_NNS_MST

a. Note all items need to be in same folder for MATLAB to run Correctly
b. Make sure the Scale at the top of the Script is set to what is the appropriate
conversion between pixels and millimeters based on the image taken
(default is for 50 times magnification)
i. This can be done by measuring how many pixels your scale in
ImageJ is with the straight line tool

5 — scale=2420; % number of pixels per mm in original image

c. When Prompted to select file select the Excel File you just saved
d. Will need the area of the Region of Interest in pixels
i. This is obtained through ImageJ using the Wand Tracing TOOIM
1. If background is black set tool to have a tolerance of
around 240
a. Adjust this to get best fit around the edge of the
sample
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2. If any of the Region of interest isn’t selected you can
manually add back in parts by using the Paintbrush tool

Figure 1 is the Minimum Spanning Tree and Figure 2 is just the center of

the dendrites
All the calculations are automatically saved to an Excel file in the same

folder called XY_TD_PDAS
i. Note the data Row 4 Column J and beyond is in Micrometers
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APPENDIX E

Table IX COMPLETE SUMMARY OF RESULTS FOR PB-SB-12-24

Sample ID Loc- Number of Area | fe | Cs | fs D TD NNS NNS Gm Gl NNS Delta Freez D
ation Dendrites _Avg _STD _Avg _STD _HL T _Time _Pred
UNITS cm mm? wt% um pum um um K/cm | K/cm um S um
Pb-Sh-12-24-14-1 1 67.89 | 0.28 | 4.32
Pb-Sh-12-24-14-2 2 70.64 | 0.31 | 4.64
Pb-Sh-12-24-14-3 3 223 70.90 | 0.33 | 490 | 0.04 | 140.24 8.73 399.42 77.03 10.50 | 11.25 568 34.05 3130 100.07
Pb-Sh-12-24-14-4 4 70.65 | 0.34 | 5.04 | 0.09 10.65 | 11.50 566 34.01 3083 98.87
Pb-Sh-12-24-14-5 5 301 70.90 | 0.37 | 5.28 | 0.13 | 129.78 8.05 355.11 68.27 10.80 | 11.75 567 33.96 3035 97.23
Pb-Sh-12-24-14-6 6 70.28 | 0.36 | 5.24 | 0.18 10.80 | 12.00 561 33.96 3035 97.42
Pb-Sh-12-24-14-7 7 258 7145 | 0.34 | 499 | 0.22 129.81 8.47 366.32 74.00 10.80 | 12.25 549 34.01 3040 98.67
Pb-Sh-12-24-14-8 8 69.10 | 0.34 | 4.96 | 0.27 10.80 | 12.50 544 34.02 3040 98.81
Pb-Sh-12-24-14-9 9 70.60 | 0.34 | 5.05 | 0.31 11.45 | 12.75 541 34.00 2866 96.51
Pb-Sh-12-24-14-10 | 10 347 7040 | 0.35 | 5.08 | 0.36 | 129.94 8.82 341.27 58.49 12.10 | 13.00 537 33.98 2711 94.61
Pb-Sh-12-24-14-11 11 70.29 | 0.35 | 5.11 | 040 12.10 | 13.25 534 33.97 2710 94.45
Pb-Sh-12-24-14-12 | 12 70.15 | 0.34 | 4.98 | 0.44 12.20 | 13.50 526 34.00 2690 94.82
Pb-Sh-12-24-14-13 | 13 471 70.02 | 0.33 | 4.85 | 0.49 | 128.72 9.11 320.55 43.91 12.10 | 13.80 518 34.02 2714 95.71
Pb-Sh-12-24-14-14 | 14 455 69.80 | 0.34 | 5.01 | 053 | 125.91 7.91 321.67 43.82 12.95 | 14.70 508 33.97 2532 92.82
Pb-Sh-12-24-14-15 | 15 70.03 | 0.34 | 5.04 | 0.58 13.80 | 15.60 496 33.95 2375 90.75
Pb-Sh-12-24-14-16 | 16 458 7053 | 0.34 | 4.99 | 0.62 | 124.34 8.35 318.87 45.51 13.80 | 16.50 483 33.95 2375 90.99
Pb-Sh-12-24-14-17 | 17 70.77 | 0.35 | 5.10 | 0.67 13.80 | 17.40 474 33.92 2372 90.46
Pb-Sh-12-24-14-18 | 18 70.17 | 0.35 | 515 | 0.71 13.80 | 18.30 465 33.89 2371 90.23
Pb-Sh-12-24-14-19 | 19 530 70.34 | 0.36 | 5.18 | 0.76 | 118.60 8.24 299.14 40.01 14.00 | 19.20 456 33.87 2335 89.65
Pb-Sh-12-24-14-20 | 20 69.62 | 0.38 | 5.41 | 0.80 14.65 | 20.10 452 33.81 2228 87.31
Pb-Sh-12-24-14-21 | 21 70.30 | 0.39 | 5,57 | 0.84 1550 | 21.00 446 33.77 2103 85.07
Pb-Sh-12-24-14-22 22 510 70.15 | 0.40 | 5.65 | 0.89 107.33 8.44 299.02 47.45 15.50 | 21.90 440 33.73 2101 84.72
Pb-Sh-12-24-14-23 | 23 70.04 | 0.44 | 6.07 | 0.93 16.35 | 22.80 439 33.64 1986 81.69
Pb-Sh-12-24-14-24 | 24 514 69.87 | 0.46 | 6.28 | 0.98 94.08 68 288.41 48.87 16.35 | 23.70 435 33.58 1983 80.93
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Table X COMPLETE SUMMARY OF RESULTS FOR PB-SB-12-22

Sample ID Loca- Number of Area fe | Cs | fs TD TD NNS NNS Gm Gl NNS Delta Freez D
tion Dendrites (mm”"2) _Avg _STD _Avg _STD _HL T _Time _Pred
UNITS cm mm? Wit% um um um um Klcm | K/cm um s um
Pb-Sbh-12-22-14-1 1 69.84 0.36 | 5.19
Pb-Sh-12-22-14-2 2 69.26 0.20 | 3.40
Pb-Sh-12-22-14-3 3 489 70.24 0.34 | 504 | 0.04 | 8894 6.21 257.79 55.96 8.30 | 9.20 319 32.53 621 59.10
Pb-Sh-12-22-14-4 4 69.85 0.38 | 541 | 0.09 8.30 | 9.20 326 32.37 618 58.00
Pb-Sh-12-22-14-5 5 362 69.93 0.36 | 5.22 | 0.13 85.60 8.20 269.15 89.40 8.30 | 9.20 322 32.45 620 58.55
Pb-Sh-12-22-14-6 6 69.80 0.38 | 544 | 0.18 8.30 | 9.20 326 32.36 618 57.91
Pb-Sh-12-22-14-7 7 420 69.72 0.39 | 553 | 0.22 79.59 7.14 255.75 68.82 8.30 9.20 328 32.32 617 57.65
Pb-Sh-12-22-14-8 8 69.65 0.38 | 544 | 0.27 8.30 | 9.20 326 32.36 618 57.91
Pb-Sh-12-22-14-9 9 456 69.70 0.39 | 557 | 0.31 77.55 6.73 243.45 68.46 8.60 | 9.70 321 32.30 595 56.87
Pb-Sh-12-22-14-10 10 399 69.73 0.34 | 5.04 | 0.36 81.72 8.32 256.21 80.69 9.00 | 10.10 305 32.52 573 57.53
Pb-Sh-12-22-14-11 11 69.88 0.36 | 5.17 | 0.40 9.35 | 10.60 301 32.47 550 56.43
Pb-Sh-12-22-14-12 12 478 69.53 0.37 | 5.37 | 0.44 78.42 7.74 246.65 79.70 9.70 | 11.00 299 32.38 529 55.18
Pb-Sh-12-22-14-13 13 74.14 0.39 | 5,53 | 0.49 10.10 | 11.50 295 32.31 507 54.02
Pb-Sh-12-22-14-14 14 561 73.23 0.39 | 559 | 053 74.19 6.25 229.01 59.39 10.50 | 11.90 292 32.29 487 53.18
Pb-Sh-12-22-14-15 15 72.59 0.39 | 555 | 0.58 11.10 | 12.40 286 32.30 461 52.30
Pb-Sh-12-22-14-16 16 771 72.32 0.38 | 545 | 0.62 70.55 4.63 216.28 59.90 11.80 | 12.80 280 32.35 434 51.51
Pb-Sh-12-22-14-17 17 70.82 0.39 | 551 | 0.67 12.10 | 13.30 276 32.32 423 50.93
Pb-Sh-12-22-14-18 18 922 70.61 0.40 | 5.65 | 0.71 69.06 3.78 205.30 42.67 12.10 | 13.80 273 32.26 423 50.59
Pb-Sh-12-22-14-19 19 70.06 0.40 | 5.70 | 0.76 12.80 | 14.60 267 32.24 399 49.53
Pb-Sh-12-22-14-20 20 918 70.36 0.41 | 5.76 | 0.80 62.61 3.75 202.68 44.84 13.70 | 15.40 261 32.21 373 48.29
Pb-Sh-12-22-14-21 21 69.94 0.41 | 5.78 | 0.84 14.50 | 16.20 255 32.20 352 47.34
Pb-Sh-12-22-14-22 22 932 68.89 0.48 | 6.49 | 0.89 58.93 3.29 196.74 45.77 15.30 | 17.00 258 31.92 331 45.03
Pb-Sh-12-22-14-23 23 69.21 0.48 | 6.51 | 0.93 16.00 | 17.60 254 31.91 316 44.35
Pb-Sh-12-22-14-24 24 869 67.31 0.59 | 7.60 | 0.98 45.53 3.71 193.35 44.63 16.70 | 18.40 261 3151 299 41.83
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Table XI COMPLETE SUMMARY OF RESULTS FOR PB-SB-3

Sample ID Location Number of Area (mm”2) fe Cs TD _Avg TD NNS NNS Gm Gl NNS _HL | Delta_T Freez D
(cm) Dendrites _STD _Avg _STD ~Time _Pred
UNITS cm mm? wt% um um um um Kicm | Kilcm um s pm

Pb-Sh-3-16 -83.00 648 123.54 0.31 4.84 140.70 11.15 344.58 48.38 12.56 10.01 506 34.11 2963 101.09
Pb-Sb-3-14 -60.00 676 122.59 0.36 | 5.50 132.07 12.16 343.38 53.27 1255 | 10.29 522 33.97 2870 97.00
Pb-Sbh-3-10 -29.00 735 125.22 0.40 5.92 119.69 9.78 336.79 52.91 12.54 10.67 532 33.88 2761 94.04
Pb-Sh-3-8 -17.50 723 124.27 0.33 5.16 126.69 9.71 333.37 51.14 12.53 10.81 515 34.04 2738 97.00
Pb-Sh-3-6 -9.00 843 125.82 0.36 | 5.50 126.40 11.61 304.49 48.89 1257 | 10.94 522 33.97 2700 95.06
Pb-Sh-3-5 -3.50 876 125.62 0.31 4.90 126.28 12.58 299.50 46.02 12.79 11.18 504 34.09 2651 97.18
Pb-Sb-3-32 -0.81 380 0.38 | 574 145.78 20.33 306.55 48.31 1290 | 11.30 521 33.91 2610 93.02
Pb-Sbh-3-33 -0.45 174 0.52 7.26 147.38 15.94 317.43 70.17 12.92 11.32 553 33.62 2583 87.35
Pb-Sh-3-34 0.25 119 0.27 4.45 143.44 14.27 304.87 49.25 12.95 11.35 490 34.19 2619 99.02
Pb-Sh-3-35 1.00 107 0.28 4.54 135.90 10.76 315.71 58.31 12.98 11.38 492 34.17 2611 98.45
Pb-Sh-3-36 2.02 123 0.29 4.62 133.33 8.02 297.84 58.26 13.02 11.43 493 34.15 2598 97.89
Pb-Sbh-3-37 3.09 99 0.49 | 7.00 121.31 12.39 308.17 50.80 13.06 | 11.47 545 33.67 2553 87.83
Pb-Sh-3-4 3.50 184 30.44 0.36 | 554 114.83 8.80 296.96 52.24 13.08 | 11.49 514 33.95 2570 93.36
Pb-Sh-3-3 8.00 183 30.57 0.29 | 4.63 122.49 7.31 291.52 7477 1326 | 11.69 490 34.14 2540 97.11
Pb-Sh-3-2 12.00 206 30.31 0.31 | 4.87 120.59 8.77 281.92 55.74 1343 | 11.86 493 34.09 2499 95.45
Pb-Sh-3-1 15.00 204 30.80 0.33 | 5.10 119.80 8.01 281.51 46.04 1355 | 12.00 496 34.04 2466 93.98
Pb-Sh-3-20 28.37 126 20.08 0.37 | 5.62 117.87 7.23 293.88 51.68 14.09 | 1258 499 33.92 2345 90.27
Pb-Sh-3-22 390.87 130 23.62 041 | 6.10 108.94 6.78 321.97 56.36 1463 | 13.16 500 33.82 2235 87.06
Pb-Sbh-3-25 66.87 160 26.50 042 | 6.17 105.51 7.02 313.64 62.98 16.71 | 15.43 473 33.78 1904 82.36
Pb-Sbh-3-27 89.87 192 29.40 049 | 6.92 94.78 7.47 310.16 56.05 1849 | 17.37 466 33.61 1683 76.81
Pb-Sb-3-30 133.87 175 30.33 051 | 7.12 79.09 5.17 305.12 64.78 21.88 | 21.08 435 33.53 1383 71.50
Pb-Sb-3-31 148.87 123 29.26 053 | 741 80.95 6.97 315.05 88.73 23.03 | 22.35 430 3347 1302 69.38
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Table XII COMPLETE SUMMARY OF RESULTS FOR PB-SB-1

Sample ID Location Number of Area (mm”2) fe Cs | TD_Avg TD NNS NNS Gm Gl NNS _HL | Delta_T Freez D
(cm) Dendrites _STD _Avg _STD _Time _Pred
UNITS cm mm? Wit% um um um pum Kicm | Klcm um s um

Pb-Sh-1-20 -93.00 130 29.93 0.24 | 461 158.29 11.34 359.67 50.13 10.93 | 11.06 586 34.30 3607 109.26
Pb-Sbh-1-19 -73.00 170 30.27 0.23 4.55 158.31 13.70 321.49 54.20 12.44 12.92 547 34.28 3167 105.03
Pb-Sh-1-18 -53.00 199 32.38 0.20 | 4.03 152.53 10.87 314.93 48.31 1395 | 14.78 504 34.35 2830 104.16
Pb-Sbh-1-17 -43.00 205 30.87 0.21 4.19 149.47 10.73 297.34 39.10 14.71 15.71 495 34.30 2680 101.41
Pb-Sbh-1-16A -33.00 198 30.22 0.22 4.35 145.56 11.74 304.09 43.45 15.46 16.64 487 34.25 2547 98.86
Pb-Sbh-1-1 -28.00 206 30.35 0.17 3.61 150.46 11.42 302.54 48.60 15.84 17.10 465 34.40 2496 102.54
Pb-Sb-1-4 -16.80 222 30.39 0.22 4.40 148.09 9.97 292.28 42.61 16.69 18.14 471 34.22 2357 96.14
Pb-Sbh-1-6 -9.60 220 30.11 0.23 4.49 143.64 10.49 289.98 50.54 17.21 18.83 466 34.19 2283 94.70
Pb-Sh-1-7 -6.40 223 30.00 0.21 4.20 143.08 10.12 285.04 40.24 17.32 19.22 456 34.24 2272 96.06
Pb-Sh-1-8 -3.30 218 30.03 0.26 4.89 142.48 8.06 283.63 45.17 17.42 19.60 466 34.10 2250 92.34
Pb-Sh-1-9 -0.70 204 30.00 0.25 4,75 142.45 9.64 292.19 46.81 17.51 19.92 461 34.12 2240 92.86
Pb-Sbh-1-11 4.40 1159 125.90 0.28 5.13 145.49 14.98 260.87 42.36 17.68 20.55 462 34.04 2213 90.79
Pb-Sh-1-12 7.40 1137 126.31 0.26 | 4.93 152.49 14.59 270.84 36.34 17.78 | 20.92 455 34.07 2202 91.53
Pb-Sh-1-13 10.40 1056 126.11 0.27 5.05 145.39 13.37 277.46 38.08 17.88 | 21.29 454 34.04 2188 90.81
Pb-Sh-1-14 14.10 1027 126.50 0.23 | 451 149.63 16.07 275.34 40.61 18.00 | 21.74 440 34.13 2180 93.20
Pb-Sh-1-15 19.20 1177 127.17 0.20 | 4.0 153.97 16.69 269.23 39.76 18.17 | 22.37 427 34.20 2164 95.09
Pb-Sh-1-16 26.80 1303 128.76 0.24 | 4.67 147.63 15.40 266.20 38.87 18.43 | 23.30 431 34.08 2125 91.67
Pb-Sh-1-2 37.00 1303 126.11 0.26 | 4.91 141.04 13.19 262.06 40.34 18.77 | 24.56 425 34.01 2083 89.98
Pb-Sh-1-22 52.00 1097 126.68 0.28 5.19 124.66 10.93 280.16 40.73 20.59 | 23.93 435 33.97 1896 86.10
Pb-Sh-1-23 67.00 1073 126.76 0.30 5.49 118.15 10.59 279.94 42.06 2250 | 23.12 446 33.93 1733 82.46
Pb-Sh-1-24 82.00 1166 126.43 0.39 6.67 107.52 8.05 274.02 43.90 2441 | 22.31 471 33.74 1589 76.29




Where the following labels signify:

fe

Cs
TD_Avg
TD_STD
NNS_Avg
NNS_STD
Gm

Gl
NNS_HL
Delta T
Freeze Time

TD_Pred

fraction eutectic

average concentration

average trunk diameter

standard deviation for measured trunk diameter values
average nearest neighbor spacing

standard deviation for measured nearest neighbor spacing
mushy zone thermal gradient

thermal gradient near the tip

Hunt-Lu® predicted nearest neighbor spacing values
undercooling near the tip

time it takes to freeze leading fluid near the tip

Tewari et. al predicted trunk diameter values
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